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Preface 

Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology 

Network (OTN) web site http://www.oracle.com/technetwork/documentation/agile-085940.html 

contains the latest versions of the Agile PLM PDF files. You can view or download these manuals 

from the web site, or you can ask your Agile administrator if there is an Agile PLM Documentation 

folder available on your network from which you can access the Agile PLM documentation (PDF) 

files. 

Note To read the PDF files, you must use the free Adobe Acrobat Reader version 9.0 or later. 
This program can be downloaded from the Adobe web site http://www.adobe.com. 

The Oracle Technology Network (OTN) web site 

http://www.oracle.com/technetwork/documentation/agile-085940.html can be accessed through 

Help > Manuals in both Agile web Client and Agile Java Client. If you need additional assistance or 

information, please contact My Oracle Support (https://support.oracle.com) for assistance. 

Note Before calling Oracle Support about a problem with an Agile PLM manual, please have 
the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 

United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 

Outside the United States, call +1.407.458.2479. 

Readme 

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle 

Technology Network (OTN) web site http://www.oracle.com/technetwork/documentation/agile-

085940.html. 

Agile Training Aids 

Go to the Oracle University web page 

http://www.oracle.com/education/chooser/selectcountry_new.html for more information on 

Agile Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 

conventions for writing code require that closing braces should appear on an otherwise empty 

line; however, some screen readers may not always read a line of text that consists solely of a 

bracket or brace.  

This documentation may contain links to web sites of other companies or organizations that 

http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.adobe.com/
http://www.oracle.com/technetwork/documentation/agile-085940.html
https://support.oracle.com/
http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.oracle.com/education/chooser/selectcountry_new.html


 

v9.3.1.2 vii  

 
 

Oracle does not own or control. Oracle neither evaluates nor makes any representations regarding 

the accessibility of these web sites.  





 

v9.3.1.2 1  

 
 

Chapter 1 

Introducing Agile Drive 

This chapter includes the following: 

 Working with Agile Drive ...................................................................................................................... 1 

 Limitations ........................................................................................................................................... 2 

 Definitions ............................................................................................................................................ 3 

 Structure of Agile Drive ........................................................................................................................ 3 

Agile Drive is a system of managing the file attachments of Agile objects from your computer 

system in the form of files and folders, without requiring you to invoke Agile PLM application. It 

connects Agile's Distributed File Manager as a network place on your system, thus enabling 

Explorer like operations, such as copy or delete, on file attachments of Agile objects. It simplifies 

file management, leveraging existing intuitive client applications, like Explorer, Mac Finder, etc. 

Working with Agile Drive 

Working with Agile Drive enables you to use the Files and Folders available in Agile PLM without 

having to download them. With Agile Drive, you can carry out the following actions: 

1. Work on Files, such as documents, drawings, etc., associated with Agile objects as File 

Attachments in Agile PLM System 

 View a File: Opens a file directly from an Agile Drive folder to view it in its native 

application, without downloading or checking out. 

 Save a File: Saves a file directly in an Agile Drive folder, thus creating a File Attachment to 

the corresponding Agile object in the Agile PLM System.  

 Edit a File: Edits a file in its native application directly from an Agile Drive folder without 

downloading or checking out. To create a new version, save it as a new file. 

 Create a File: Creates a new file in Agile Drive using drag and drop from a non-Agile Drive. 

 Delete a File: Deletes a file from an Agile Drive folder using Delete key, which in turn deletes 

the File Attachment from the corresponding Agile object in the Agile PLM System.  

 View File Properties: Views file properties, such as data of creation, date of last 

modification, size, etc. Right-click a file in the Agile folder to locate View File Properties.   

 Add a File: Adds a file from your local drive, or any non-Agile network drive, into an Agile 
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Drive folder. Agile Drive stores this file as a File Attachment to the corresponding Agile 

object in Agile PLM system. Agile Drive creates a version of every file that you add (this 

applicable only for Design and File Folder objects). You can choose either  the Drag-Drop 

option or Copy-Paste option to add a file.  

 Move a File: Moves a file from Agile Drive folder. You can Cut-Paste a file from Agile Drive 

folder. Agile Drive creates a version of every file that you remove (this is applicable only 

for Design and File Folder objects). 

 Copy Files: Copies files from a non-Agile Drive folder into an Agile Drive folder, and vice-

versa. Drag and drop the required file. 

2. Work on Folders 

 View Folder Properties: View file properties, such as number of files within, etc., of an Agile 

Drive folder by selecting Properties from right-click menu. 
 

Limitations 

The release of Agile Drive does not support the following functionalities: 

File Functions 

 Save a file to a folder on the Agile Drive. However, you can use Save As option to save a file 

under different name.  

 Rename a file 

 Check-in files from Agile Drive folders 

 Check-out files into Agile Drive folders 

 Create files in Agile Drive folder 

 Extract data out of an uploaded file in Agile PLM 

 Undo operations 

Folder Functions 

 Create Agile Drive folders  

 Copy-Paste or Drag-Drop an Agile Drive folder into another Agile Drive folder 

 Copy-Paste or Drag-Drop a non-Agile Drive folder to an Agile Drive folder 

 Rename an Agile Drive Folders 

Business Functions 

 Affected Items & BOM revisions rendering only for ECOs 

 Design Structure expansion 

 Workflow approvals  
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 Status change 

 No display of Application data (Cover page/P2/P3) 

 PPM Content Tab is not supported 
 

Definitions 

Name Descript ions  

Agile Drive A file system that helps manage the files attached to objects in the Agile PLM 

system. It is a logical representation of the Agile PLM objects and their associated 

attachments. 

Agile object An entity defined in Agile PLM that groups a set of attributes and relationships 

related to that object.  

Examples: Item, Folder, etc.  

Agile PLM 

folder 
A folder in Agile PLM system that holds attachments of other Agile objects, such 

as Item, Change Order, etc. Agile PLM folder is also treated as an independent 

Agile object. 

Agile Drive 

folder 
A folder that represents an Agile object on your system.  

non-Agile 

Drive folder 
A folder on your system drive or any network drive other than Agile Drive. 

 

Structure of Agile Drive 

Agile Drive displays Agile objects as folders, and its Attachments as files in these folders. The table 

below gives us a better understanding of Agile objects in both; Agile Drive and Agile PLM system. 

Ent i ty  In  Agi le  PLM Sysytem  In  Agi le  Dr ive  

Part  A Part is an Agile object.  

Example - P00003 

A Part is a folder, called as Agile Drive 

folder, named after the Agile object it 

represents. 

Example - P00003 

Revision A Revision is a state of an Agile 

object.  

Example - Introductory 

A Revision is a Sub-folder, again called 

as Agile Drive folder, named after the 

Revision state of the Agile object it 

represents.  

Example - Introductory 
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Ent i ty  In  Agi le  PLM Sysytem  In  Agi le  Dr ive  

Attachments An Attachment is a file associated to 

an Agile object.  

Example  

- agile_20090224_075051312.axml 

- agile_20090224_113543937.axml 

- MirrorBolt1.SLDPRT 

An Attachment is a Agile Drive file 

contained in an Agile Drive folder. The 

name of this Agile Drive file is exactly 

the same as that of corresponding 

Attachment.  

Example  

- agile_20090224_075051312.axml 

- agile_20090224_113543937.axml 

- MirrorBolt1.SLDPRT 

 

   Agile Drive: An Agile Object and its File Attachments in Agile Drive  

    

   Agile PLM: An Agile Object and its File Attachments in Agile Application 
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Chapter 2 

Setting up the Agile Drive 

This chapter includes the following: 

 Enabling Agile Drive in Java Client ...................................................................................................... 7 

 Configuring the Agile Drive Settings .................................................................................................... 8 

 Deployment Architecture ..................................................................................................................... 9 

 Mapping Agile Drive............................................................................................................................. 10 

 

Enabling Agile Drive in Java Client 

When you deploy Agile PLM, by default, the Agile Drive is set as Disabled. To use Agile Drive, ensure 

to enable it in Java Client. 

To enable Agile Drive: 

1. In Java Client, go to System > Preferences. 

2. From the Agile Drive dropdown list, select Enabled.  

Note By default, Agile Drive is set to Disabled. 

 

Once you enable the Agile Drive, the access will be Read-only. To change the access to Read-Write, 

see Configuring the Agile Drive Settings. 

3. Restart all Distributed File Managers. 
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Configuring Agile Drive Settings 

As an Administrator, you have to set the property 'readonly:mode' as FALSE in the settings.conf file 

located at  

Name URL Descript ion  

app.server.url http://<Server>:<Port>/Agile/RMIServlet URL of Agile PLM 

Application Server  

file.server.url http://<Server>:<Port>/Filemgr/services/FileServer URL of Agile PLM File 

Manager  

# User account 

user.name ifsuser Agile User ID 

user.pwd 221B758BAAE4C4 Agile User Password 

Appears in encrypted form 

# Turns on/off read-only mode 

readonly.mode TRUE Turns on “Read-only” mode – Does not allow add/delete file 

actions. Default = “True” 

# Cache Tuning parameters 

cache.reload.interval 2 The number of times a user is required to refresh the view 

within a short interval to force refresh cache. 

cache.timeout 30 Time to live (TTL) for cache entries. 

Inactive cache entries are cleaned out from the Agile Drive 

after 30 minutes. 

The minimum cache timeout is 20 minutes. 

# Encodes directory names using HTML URL Encoding 

name.encoding FALSE Enables HTML URL encoding on folder names. 

# Exclusion Filter - Used to exclude certain file types (for all users) 

# The specified file types will be filtered out of the file list 

# Usage: exclude.filetypes - doc,dwg,prt 

exclude.filetypes Specify the Files Types that should be filtered out from being displayed. 

For example, to filter out Word files and show only PDFs, set 

exclude.filetypes=doc. 

# Max folders to display in results. Applicable to Search Results & BOM. 
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# Minimum Value > 250 

max.rows 1000 Maximum Number of folders.  

Applicable to BOM and search results. 

Minimum value = 250 

Maximum value = 5000 
 

Platform Settings 

1. Microsoft Windows Explorer - XP/Vista 

Web Folders Client is bundled in XP/Vista. Download and install Microsoft Web Folder Update 

KB907306 from  

http://www.microsoft.com/downloads/details.aspx?FamilyId=17C36612-632E-4C04-9382-

987622ED1D64&displaylang=en 

2. MAC OSX Finder 

Disable creation of intermediate file store (.DS_Store), which is used for file uploads to work 

correctly. 

http://support.apple.com/kb/HT1629  

3. IIS Support 

Only IIS 6.0 & 7.0 are supported. 

Ensure to set the WebDAV Web Service Extension to Allowed. 

Optional Settings 

1. Search Timeout 

Agile Searches on Windows XP/Vista can timeout after 30 seconds. This is due to the timeout 

feature of Microsoft Internet Explorer 7.  

To increase the Microsoft Client timeout, add a ReceiveTimeout DWORD value with a data 

value of (<number of seconds>)*1000 in the Registry settings as follows: 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Internet Settings 

Example: If you want the timeout duration to be 8 minutes, set the ReceiveTimeout data value 

to 480000 (<480>*1000). 

Reboot the computer system.  

Deployment Architecture 

 XML based request/response model 

 Customized version of Tomcat 6.0 Web DAV Servlet 

 Supported on most platforms 

http://www.microsoft.com/downloads/details.aspx?FamilyId=17C36612-632E-4C04-9382-987622ED1D64&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=17C36612-632E-4C04-9382-987622ED1D64&displaylang=en
http://support.apple.com/kb/HT1629


Agile Drive User Guide  

 

 

10 Agile Product Lifecycle Management 

 
 

 Deployed on File Manager instance as a new Web Application 

 Communicates with Application Server for object meta data 

 Caching for better performance 
 

Mapping Agile Drive 

You can map Agile Drive on one of the following operating systems. 

 On Windows XP System on page 10 

 On Windows Vista System on page 11 

 On Macintosh System on page 12 

 On GNOME Linux System on page 12 

 On KDE  Linux System on page 13 
 

On Windows XP System 

To map Agile Drive on your MS Windows XP system: 

Note You cannot deploy Agile Drive on Windows XP-64 and Windows 7 since they do not 
contain the web folders component. 

1. On the desktop, double-click My Network Places icon. 

 

2. Click the Add a network place link. 

3. In the Add Network Place Wizard, click Next. Choose a network location. 

4. Enter the IP Address of server where Agile Drive is deployed, together with its Port Number and 

the Folder Name, as follows: 

http://<Host Name or IP Address>:<port>/webdav/ 

Note Use host name/IP address of web proxy or Tomcat server where Agile Drive is 
deployed (same as Agile File Manager by default). 

Note Contact your Agile Administrator for the IP Address and complete path of Agile 
Drive. 

5. Click Next. In the Connection window that pops up, enter your Agile PLM User name and 

Password. 

Note Contact your Agile Administrator for User Name and Passwod. 

If you do not want the Agile Drive to ask you for User Name and Password each time you 
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connect, check the Remember my password check box. 

6. Click OK. Enter a name for the network place. You can change this name to one of your choice.  

7. Click Next. 

8. Click Finish. 

The Agile Drive folder window opens up. 

On Windows VISTA System 

To map Agile Drive on your Windows VISTA system: 

1. Click Computer in the Start Menu. 

In the Computer window, click the Map a Network Drive icon. 

In the Map Network Drive wizard window, click the Connect to a Web site that you can use to store 

your documents and pictures link. 

In the Add Network Location Wizard, click Next. Choose a custom network location. 

2. Specify the location of your website. 

3. Select Choose a custom network location. 

4. Enter the IP Address of server where Agile Drive is deployed, together with its Port Number and 

the Folder Name, as follows: 

http://<Host Name or IP Address>:<port>/webdav/ 

Note Use host name/IP address of web proxy or Tomcat server where Agile Drive is 
deployed (same as Agile File Manager by default). 

Note Contact your Agile Administrator for the IP Address and complete path of Agile 
Drive. 

5. Click Next. 

6. In the Connection window that pops up, enter your Agile PLM User name and Password. 

Note Contact your Agile Administrator for User Name and Agile Drive.  

If you do not want the Agile Drive to ask you for User Name and Password each time you wish 

to connect, select the Remember my password check box.  

7. Click OK. Enter a name for network location. You may change this name to one of your choice.  

8. Click Next.  

9. Click Finish.  

The Agile Drive folders window opens. 

Important Agile Drive folders do not open in Windows VISTA by double-clicking. Right-click on it 
and select Open.  
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On Macintosh System 

To map Agile Drive on the Macintosh system: 

1. Select Connect to Server from Go in Main Menu. 

2. In the Connect to Server window, enter the IP Address of the server where Agile Drive is 

deployed, together with Port Number and Folder Name, as follows: 

http://<Host Name or IP Address>:<port>/webdav/ 

Note Use host name/IP address of web proxy or Tomcat server where Agile Drive is 
deployed (same as Agile File Manager by default). 

Note Contact your Agile PLM Administrator for required data values. 

3. Click Connect. 

4. Enter your Agile PLM User Name and Password. 

5. Click OK.  

The Agile Drive folder window appears. 

On GNOME Linux System 

To map Agile Drive on the GNOME Linux system: 

1. Select Connect to Server... from Places in the Main Menu. 

The Connect to Server screen appears. 

 

2. Enter the following parameters: 

Service type Select WebDAV (HTTP) from the drop-down list. 

Server Enter the IP Address of the server where Agile Drive is 

deployed.  

Port Enter Port Number of the server. The default value is 80.  
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Folder Enter webdav in lower case.  

User Name Enter your Agile PLM User Name. 

Name to use for 

connection 

Enter any name of your choice.  

 

Note Contact your Agile Administrator for required values.  

3. Click Connect.  

4. Enter your Agile PLM Password and click Connect.  The Agile Drive default folder window 

appears. 
 

On KDE Linux System 

To map Agile Drive on the KDE Linux system: 

1. Open Shell Console and execute knetattach.  

 

2. Select Webfolder (webdav) and click Next.  

3. Enter the following data: 

Name Enter a name of your choice.  

User Enter your Agile PLM User Name. 

Server Enter the IP Address of the server where Agile Drive is deployed.  

Port Enter Port Number of the server. The default value is 80.  

Folder Enter webdav in lower case.  

 

Note Contact your Agile Administrator for required values.  

4. Click Connect.  

The Agile Drive folder window appears. 
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Chapter 3 

Using the Agile Drive 

This chapter includes the following: 

 Searching for Agile Objects ................................................................................................................. 15 

 Working with Files and Folders ............................................................................................................ 16 

 Opening files in Agile Drive .................................................................................................................. 18 

 Tracking Versions ................................................................................................................................ 19 

 Traversing Item Revisions ................................................................................................................... 21 

 Traversing a Bill of Material ................................................................................................................. 22 

 

You can access Agile Drive using Windows Explorer, listed under My Network Places. When 

prompted, log in using your Agile PLM User Name and Password.  

For quick access to Agile Drive, you may create a shortcut of Agile Drive on your desktop or create 

its menu item in the Start Menu.  

Note MS Vista 64 bit and Windows XP 64 bit are not supported because Microsoft does not 
ship the required drivers. To open a folder, right-click on it and select Open. 

Note Your access to Agile Drive folders and files depend on the roles and privileges assigned 
to you by Agile PLM Administrator. 

 

 

Searching for Agile Objects 

You can search for Agile PLM objects using Agile's canned (predefined) queries, such as Global 

Searches and Personal Searches. A canned search query appears as a folder in Agile Drive, and the 

Search Results appear as folders within this folder. 

For example, to perform a search called Unreleased Changes That I Created, navigate to the 

corresponding Folder. All unreleased changes that you created appear as folders within this Search 

folder. Navigate to the desired unreleased change folder to see the affected items and its 

attachments, if any. 
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Search Limitations 

Any search that requires user inputs or search criteria is not a feature of Agile Drive. For example, 

you cannot search for a specific ECO, say ECO25000. To search for specific searches, you need to 

use the Explorer feature of File or Folders search. 

To search for specific folders in (MS Windows XP): 

1. Click Start > Searches > For Files or Folders... 

2. In the Search Results window, click All Files and Folders. Specify the search criterion in the 

search field(s). 

3. In the Look in drop-down list, select Browse.. A Browse for Folder window pops up. 

4. Expand My Network Places and select the Agile Drive. 

5. Click OK to return to the Search Results window. 

6. Click Search button. The specified object appears as a folder in the Search results. 
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Working with Files and Folders 

You can perform the following actions on files and folders in Agile Drive. 

Note Due to limitations of the client OS, Agile Drive error messages do not show up correctly 
on client side. 

Caution Intermittent failures can occur during multiple files addition on MAC OSX Finder. 

 

How to  Steps  

View or read a 

file 
In an Agile Drive folder, double-click a file to read or view. Alternately, select Open 

from right-click menu. The system opens the file in its associated application. 

For example, when you double-click a MS Word Document file in an Agile folder, 

your system invokes MS Word, which opens this document in editable mode. If MS 

Word is not installed in your system, you cannot view the document. 

You can open only the MS Office files directly from Agile Drive provided MS Office 

or MS Office Viewer application is installed in your system. For every other file 

type, you need to first drag and drop (or copy-paste) the file to your desktop or 

local drive and then open it with its associated application. 

Save a file In Agile Drive, you can save a file in two ways: 

Save a new file in an Agile Drive folder directly: Create a file in an application and 

click Save (or Ctrl+S). In the Save window, select the desired Agile Drive folder to 

save it in. 

Save As: If you edit a file that already exists in an Agile Drive folder, you can save 

it only as another file. Agile Drive does not support direct editing and saving of the 

same file due to versioning aspect of Agile PLM.  

Use the Save As function to copy a file from an Agile Drive folder to your system 

folder, and save it after editing.  

Delete a file Deletion of a file from an Agile Drive folder implies removal of a file attachment 

from an Agile object.  

To delete a file, select the desired file(s) in an Agile Drive folder and press Delete 

(Del) key once, or select Delete from right-click menu.  

The system deletes the file(s) without issuing any warning or requesting any 

confirmation. Agile Drive continues to display the deleted file(s) until you Refresh 

the display.  

Although the file appears deleted from Agile Drive folder, and from the 

corresponding Agile Object, the Agile PLM application does not purge it out.  
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How to  Steps  

Agile Drive does not allow deletion of a Redlined File. 

View 

properties of a 

file 

On a desired file in an Agile Drive folder, select Properties from right-click menu. 

The system displays its general properties. 

Add a file Adding a file in an Agile Drive folder implies adding a file attachment to an Agile 

object. You can do this by  

- copying & pasting  

- dragging & dropping, a file from a non-Agile Drive folder into an Agile Drive 

folder.  

You can also use Save, Save As features to save a file from an application. 

Agile Drive does not display the added file(s) until you Refresh the display.  

When you add multiple files in Read-only mode of Agile Drive, a pop-up message 

appears for each file you add. It is recommended that you add only one or two files 

at a time. 

Copy a file 

from an Agile 

Drive folder to 

a non-Agile 

Drive folder 

In an Agile Drive folder, select the desired file.  

Select Copy from right-click menu, or select Copy from Edit Menu of MS Windows 

Explorer. 

Navigate to the desired non-Agile Drive folder.  

Select Paste from right-click menu, or, select Paste from Edit Menu of MS Windows 

Explorer. 

View folder 

properties 
On a folder in Agile Drive, select Properties from right-click menu. The system 

displays its general properties.  
 

Opening files in Agile Drive 

Agile Drive supports opening only Microsoft Office format files from the Internet Explorer. 

To open files in Agile Drive: 

 For HTML, DOC, RTF, XLS, PPT and other Microsoft formats which support Microsoft clients: 

Double-click file or open within Internet Explorer after authentication. 

Note Text and PDF files do not open in Agile Drive. 

To open text and PDF files: 

1. Drag and drop the files to desktop.  

2. Click Open. 
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To open files in Adobe Reader or Notepad:  

1. Click File > Open. 

2. Navigate to Network Places > Agile Drive. 

3. Click Open. 
 

Tracking Versions 

Versioning applies to Design objects and File Folder objects of Agile PLM. When you add or delete 

a File Attachment from a Design object or a File-Folder object, Agile PLM retains the original status 

of these attachments as a Version.  

Agile Drive displays these versions as numbered folders under Previous Versions Folder in the 

'versioned' Agile object, with Version Number 1 being the oldest/earliest version of the said Agile 

object. 

This can best be understood with an example, as follows: 

1. In Agile Drive, select FOLDER00947, as shown in Screen 1. It contains three files.  

FOLDER00947 in Agile Drive is an Agile PLM File Folder Object, which has three file attachments. 

Screen 1: Select a folder in Agile Drive 

 

2. Add a File in FOLDER00947. The folder now contains four files. 

       Screen 2: Add a fi le 

 

3. Wait for a few seconds and Refresh (press Ctrl+F5) the Explorer view.  

A Previous Versions folder, and a sub-Folder numbered as 1, appears under FOLDER00947. This 

implies, FOLDER00947 is the 'latest' version of File-Folder Object, which now has four file 

attachments. 
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Screen 3: Previous Versions Folder 

 

4. Go to the Folder 1 under Previous Versions folder.  

It contains the three files that originally existed in FOLDER00947 before you added the fourth 

file. This implies, the 'earlier' version of the File-Folder Object had three file attachments. 

Screen 4: Earlier/older Version Folder - '1' 

 

5. Now go back to FOLDER00947, which is the 'latest' version. Delete one of the files, say 

Bike2.bmp. This folder now has three files. 

This implies, you have deleted a File Attachment from the File-Folder Object. 

Screen 5: Delete a File 

 

6. Wait for a few seconds and Refresh (press Ctrl+F5) the Explorer view.  

The Previous Versions folder now has two sub-folders numbered 1 and 2.  This implies, the Agile 

Drive folder number 2 is the 'previous' version of the said File-Folder object, FOLDER00947, 

and it has the four File Attachments that existed before you deleted one. 

Screen 6: Previous Version 
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Likewise, each time you add or delete any file in an Agile Drive folder (corresponding to a Design 

Object or File-Folder Object), it maintains the original files in version numbered folders under 

Previous Versions folder.  

Note You cannot Add or Delete Files from any of the Previous Version folders. 

If you delete, or purge, a version folder in Agile Application, the deleted or purged version folders 

do not appear in the corresponding Agile Drive folder.  

The number of version folders that you see depends on the settings in Agile Application.  

Note Refreshing (Ctrl+F5) the view in MS Windows XP Explorer does not display the changed 
versions in the folders (left) pane, although the changed versions appear in the right 
pane. 

 

Traversing Item Revisions 

A revision in Agile Drive appears as a 'prefix' to the Change Object. The structure of Agile Drive 

folder, thus, appears as follows: 

<Revision Name> - <Change Object Name> 

Example: In the image below, the Agile Drive folder B - ECO-00075 corresponds to Revision B of 

Change Object ECO-00075 associated to Agile object P00058. 

 

 

The Agile objects, whose revisions are not yet defined in Agile Application, are represented as  

<UNDEFINED> - <Change Object Name> 

Example: In the above image, since the new Change Object, ECO-00077 has not been assigned a 

Revision Number, it is in the Pending state it . Hence, it, appears as (UNDEFINED) - ECO-00077 in Agile 

Drive, . 

When you create a Part, its Revision state is Introductory. When you bring about a change to this 



Agile Drive User Guide  

 

 

22 Agile Product Lifecycle Management 

 
 

Part, a Revision is created, which is identified by a Revision Number. Once the Revision Number is 

assigned, it remains in the pending state until released. The Pending state is represented by 

enclosing the revision number in brackets.  

Example: In this image, (C) - ECO-00076. 

Agile Drive moves the 'earlier released revisions' into an Agile Drive folder called Other Revisions, 

except for the latest released revision. Every time an Agile object goes through a Change, the 

latest revision appears as an Agile Drive folder under the folder for the main object. 

Example: In the above image, the Agile Object P00058 had undergone a change by means of Change 

Object ECO-00064, which was revised only once as Rev-A. Later, it went through another change, 

ECO-00075, which was revised to Rev-B.  

Note Agile Drive does not display the structure of Design objects. 

 

Traversing a Bill of Material 

The Bill of Material (BOM) of an Agile object appears under its corresponding Change Object as 

Agile Drive folders. 

In a BOM, the File Attachments of a Parent Object are located in its Change Object. For example, 

the File Attachments of Part P00058 are located under the folder B - ECO-00075, which corresponds 

to the Change Object of this Part. 

The File Attachments of a Child Object are located in its corresponding Folder. For example, 100-

01014-A is the child object of P00058. 

   

 


